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Dept. of Children, Youth & Families  
Early Support for Infants & Toddlers (ESIT) Program 
State Interagency Coordinating Council (SICC) | Virtual Meeting 

Date: Wednesday, October 26, 2022 
Time: 9 a.m. – 3:00 p.m. 

Role & Purpose 

In order to carry out its mission, the Council shall advise and assist the State Lead Agency, and the 

other participating state agencies, on a broad range of policy and coordination issues. The SICC will 

promote an appreciation for the needs of children that have or are at risk for developmental delays 

or disabilities and will gain an understanding of the services required to address those needs. 

Group Agreements 

 State your name each time you speak

 Speak slowly– this helps our note-taker and interpreters

 Avoid using acronyms and jargon

 Be patient with one another as we practice Robert’s Rules of Order

 Zoom Do’s and Don’ts (Will)

 For Technical Assistance, please text Will Moncrease, Jr. at 564-999-0449

will.moncrease@dcyf.wa.gov.

Agenda 

Native Land Acknowledgement 
9-9:30 a.m. | Welcome & Introductions| SICC Vice Chair E Renae` Antalan
Welcome members, review and approve previous meeting minutes and today’s agenda.

9:30-9:50 a.m. | Micro-Training: Karin Morris, ACTCP (she/her/hers)| Email: 
Karin.morris@dcyf.wa.gov 
This is an opportunity for the SICC and audience members to continue learning about accessibility and 

ways support accessibility for all. Discuss (Outside Presenter) Language Access, Cultural Considerations. 

I am DCYF’s ADA Coordinator. I have over 10 years working advancing the rights of individuals with 

disabilities through providing technical assistance on the Americans with Disabilities Act as well as 

implementing the ADA in governmental settings. My presentation will provide an overview of the 

importance of creating accessible documents using MS Office products, common challenges that arise, 

and ways to remediate or fix them. 
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Accessible Documents: An Overview 

I. Applicable Laws & Guidelines
II. MS Office Products Tips & Tricks
III. Challenges and how to address them

9:50 – 10:00 a.m. | Break 

10: 00 a. m. – 10:30 a.m. | Parent Stories: ESIT Services & PIE Introduction (Cohort 5) 
Families will share their experience with receiving ESIT services during the COVID-19 pandemic with the 
council. Members will have an opportunity to ask questions and gain additional insights.  

10:30 – 11:00 a.m. | Committee Updates  
The SICC committee chairs will share updates, move motions and/or make recommendations to the 
council.  

11:00 a.m. – 11:20 a.m. | Public Policy Committee| Lance Morehouse & Maryanne Barnes | 
ECDAW’s and WeeCare’s legislative priorities 

11:20 a.m. – 11:30 a.m. | Public Comment  
This time is set aside for the audience to state comments and share feedback on topics discussed in the 
morning. If the individual providing comment would like their comment to be included in the meeting 
minutes, they must provide a written summary to the SICC Chair Darci Ladwig 
zoeandmomma@gmail.com.  

11:30 – 11:40 a.m. | Break 

11:40 a.m.  – 12 p.m. Laurie Thomas ESIT | Final Draft Letter to OSEP. 

12 – 12:30 p.m. | Lunch Break 

12:30 p.m.  – 1:30 p.m. Agency Updates  
This is an opportunity for SICC state agency representatives to share insights, request advice/assistance 
from the council, and make announcements of upcoming events/activities.  

1:30 – 1:40 p.m. Break 

1:40 p.m. – 2: 25 p.m.| From Boarding School to Resiliency | Sheryl Fryberg

I am the Executive Director for the Betty J Taylor Early Learning Academy. I have been working directly in 

Early Learning for 8 years and have an additional 12 years as the Executive Director of Health and 

Human Services at Tulalip Tribes and Early Learning was one of my many programs. I was the Liaison 

with the local school district for Tulalip for 20 years. My presentation is “From Boarding School to 

Resiliency”. The presentation will briefly cover history and the resilience of our Native American people. 

mailto:zoeandmomma@gmail.com
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2:25 - 2:35 p.m. Public Comment 
This time is set aside for the audience to state comments and share feedback on the SICC meeting 
overall. If the individual providing comment would like their comment to be included in the meeting 
minutes, they must provide a written summary to the SICC Chair Darci Ladwig 
zoeandmomma@gmail.com.  

2:35 – 3:00 p.m. | Evaluation & Wrap Up 
Members will have an opportunity to share their input on the day and make recommendations for 
future meeting topics.  

Next SICC Meeting: 

Wednesday, January 18, 2023 | Virtual 

mailto:zoeandmomma@gmail.com


Dept. of Children, Youth & Families  
Early Support for Infants & Toddlers (ESIT) Program 
State Interagency Coordinating Council (SICC) | Virtual Meeting 

Date: Wednesday, July 20, 2022 
Time: 9 a.m. – 3 p.m. 

9-9:35 a.m. | Welcome & Introductions

• SICC Vice Chair, E Renae` Antalan welcomed meeting attendees

• Meeting Role & Purpose statement reviewed by E Renae Antalan

• Will Moncrease, Jr. shared meeting do’s and don’t’s

• Group agreements shared by E Renae Antalan

• SICC member, Sheryl Fryberg, Tulalip Tribes, expressed a heartfelt Washington Land 
acknowledgment and a speech from Chief Seattle.

o Native Land is an app to help map Indigenous territories, treaties, and languages.
o The Office of Native Education (ONE) provides assistance to school districts in meeting 

the educational needs of American Indian and Alaskan Native (AI/AN) students.

• SICC Vice Chair, E Renae` Antalan conducted roll call. SICC members each gave land 
acknowledgements and descriptive introductions

9:35-9:45 a.m. | Parent Stories: ESIT Services 

Sara McCamman shared her family’s journey receiving early intervention services from Parent to Parent 
and ESIT, and the support they received after moving from Arizona to Olympia, WA. SICC members 
asked questions and expressed their gratitude for sharing her story. 

9:55 – 9: 55 a.m. | Approve April SICC Meeting Minutes & July Agenda 

 SICC member, Lisa Greenwald, moved to approve the April 2022 Meeting minutes and July 2022
agenda, seconded and approved.

 Last SICC member introductions.

 With the extra time E Renae` asked SICC members: does anyone have a “pay it forward
moment” that has happened to you?

9:55 – 10: 10 a.m. | Break 

10:10 – 10:40 a.m. | PIE Graduation (PIE Cohort IV) 

Vanessa Allen, ESIT Family Engagement Coordinator, overviewed the Parent Institute for 
Engagement (PIE) program and introduced the PIE graduates of cohort 4. Graduates: Gloria Castro, 
Sydney O’Brien, Alma Johnnser, Elizabeth Rhonemus, Danielle Turner, Elizabeth Paschich and 
Clariese Cote, all shared their personal journeys receiving early intervention services and learning to 
become more knowledgeable, empowered parent advocates for their children and other families. 
Hear their stories in the PIE Cohort 4 Graduation Presentation (watch time 25:47).

10: 40 – 10:55 a.m.| Break 
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10:55 a.m. – 11:45 a.m. | System of Payment and Fees Policy (SOPAF) 

Discussion on SOPAF and removing parent fees and out-of-pocket expenses. Updates from across the 
state re: progress, concerns, and challenges. Presented by Lance Morehouse, Chief Executive Officer at 
Sherwood Services, and Maryanne Barnes, Executive Director, Birth to Three Developmental Center. 
Conuncil member asked questions and discussed.  

Year-Round Funding: The annual amount of funding received per child in the Early Support for 
Infants and Toddlers (ESIT) program represents a 10-months/year annualized rate, because it is 
based on the school year. However, Early Support Providers must deliver services year-round 
per IDEA of Part C. Therefore, we should update the statutory funding model to reflect an 
additional 2 months and more adequately fund the early support system.  

First Month of Services: Per state law, early support providers are only allowed to count services 
for the purposes of billing for children that were served in the prior month. Effectively, this 
means providers are not allowed to bill for the first month of services they provide which is 
often the most expensive month. Unlike the school system, the average stay in early support is 
only a fraction of the schools and is discussed mere months, not 13-18 years. Thus, this month 
of no-funding has a much larger financial impact on the early support system. We should correct 
this so that providers are adequately paid for all children actually served in a given month. 
Written support submitted by SICC member, Lisa Greenwald with Kindering.  

11:45 – 11:50 a.m. | Public Comment 

The time is set aside for the audience to state comments and share feedback on topics discussed in the 
morning. If the individual providing comment would like their comment to be included in the meeting 
minutes, they must provide a written summary to the SICC Chair Darci Ladwig.  

11:50 a.m.  – 12:30 p.m. Committee & Agency Updates 

The SICC committee chairs shared verbal committee updates: 

 Cindy Carroll – Public Policy Committee

 Angel Fettig – Personnel & Training Committee

 Ryan Guzman – Service Delivery Committee

The SICC agency representatives shared verbal agency updates: 

 Laurie Thomas, Early Support for Infants & Toddlers (ESIT) program

 Robert Solano, Office of the Insurance Commissioner (OIC)

 Jen Chong Jewell, PAVE/SEAC, also shared the following written updates and resources:

SEAC is welcoming five members: Tamara Griffith, Natasha Hays, Soleil Lewis, Haley Lowe, Laura 
Staley. SEAC recently held elections. For the next three years, the members of the executive 
SEAC team are: Tammie Jensen-Tabor, Executive Chairperson; Jen Chong Jewell, Executive Vice 
Chairperson; and Diana Marker, Executive Member. The first meeting of the 2022–23 school 
year is planned virtually for August 23, 8:30 am–3 pm. Due to the training, the meeting is 
designated as an executive session and will be closed to the public. TAESE (Technical Assistance 
for Excellence in Special Education) is conducting the training virtually. Click here for more 
information about TAESE. 

https://www.taese.org/cms/
https://www.taese.org/cms/
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WEA's Special Education Support Center and Inclusionary Practices Project, in partnership with 
Inclusive Schooling will cover the costs for 1,500 educators (teachers, administrators, families) 
to attend and register through WEA. Register Here. 

 Sarah Burdette, Dept. of Health (DOH)

 Ryan Guzman, Office of Superintendent Public Instruction (OSPI)

 Debi Donelan, interim rep. for King County Developmental Disabilities Division (DDD)

12:30 – 12:43 p.m. | Evaluation & Wrap Up 

SICC members shared their input on the meeting, last thoughts and their summer word of the day. 

Next SICC Meeting: 

Wednesday, October 19, 2022 | Virtual 

https://cvent.me/QQDOnR


TO:  Office of Special Education Programs 

FROM: Early Support for Infants and Toddlers, Department of Children Youth and Families, Washington 

State 

SUBJECT: Requirement to Identify Child’s Race to Enroll in Part C Services & Reporting Exit Data 

To Whom it May Concern: 

Washington State’s Part C Program, Early Support for Infants and Toddlers (ESIT), enthusiastically 
supports the mission of the Office of Special Education Programs (OSEP) to lead the nation's efforts to 
improve outcomes for children with disabilities, birth through 21, and their families, ensuring access to 
fair, equitable, and high-quality education and services. Our vision is for a world in which individuals with 
disabilities have unlimited opportunities to learn and to lead purposeful and fulfilling lives. 

This letter serves as a response to concerns expressed by our providers and families regarding current 
OSEP race and gender reporting expectations.   

For a multitude of reasons, families are occasionally hesitant to disclose their child's race and ethnicity. 
Our providers have shared the experiences of families who are hesitant to disclose their child's race and 
ethnicity for a variety of reasons, including direct experiences with institutional racism. This has led to 
families declining services in some cases and left providers feeling ill at ease being asked to ‘guess’ the 
child’s race. We recognize the importance of accurate data to support the identification of 
disproportionality and potential bias, but current guidance from OSEP for providers to choose a 
racial/ethnic identifier that they believe best identifies the child when families refuse does not support 
family-centered practices or advance racial and gender equity.  

A provider has also recently shared concerns that a family intends to decline services for their child 
because there was not a non-binary option for gender. We have heard similar concerns about limited 
options for collecting data based on gender. In this case, data inaccurately captures the experiences of 
non-binary children and misses the opportunity to identify disparities for intersex, non-binary, and 
transgender children. At best this leaves gaps in our understanding of who our program serves, and at 
worst puts families in a situation where they may feel forced to decline services.   

The ESIT program shares OSEP’s vision for a world in which individuals with disabilities have unlimited 
opportunities to learn and to lead purposeful and fulfilling lives  

Please accept this request that OSEP consider additional more inclusive options for families who are 
uncomfortable with the categories provided, or uncomfortable sharing this information, and consider 
adding additional categories and or an option to decline to disclose.  

We appreciate your continued support and collaboration.  

Respectfully, 
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2023 Decision Packages 
Funded Program Implementation 
DDA requested 7.8 FTEs and $14.5 ($7.7 million GF State) in the 23 – 25 biennial budget to continue 
phase-in of programs initially funded by the Legislature that are increasing or beginning services in the 
2023-25 biennium for:  

• Youth Inpatient Navigators: DDA has 1.0 FTE Program Manager to participate in Youth Inpatient

Navigator meetings led by HCA. DDA is requesting an additional 3.0 FTEs in FY24 and 4.0 FTEs in

FY25 to align with the phasing-in of the program and teams at HCA.

• Community Supports for Children:  Continued expansion funded in the 2021-23 biennium. DDA

is requesting 1 FTE and continued phase-in of One three-bed facility Intensive Habilitation

Services and five-three bed facilities Enhanced-Out-of-Home programs in FY24 and FY 25. These

programs serve children and youth 8 – 21 who are DDA clients and will continue capacity

building needed to prevent unnecessary hospitalization.

• Transition from using IQ scores for DDA eligibility (HB2008): DDA requested 2.0 FTEs in FY24 to

implement changes to eligibility determinations required under HB2008. A program manager

and a psychologist are needed for successful implementation including extensive changes to

intake rule, policy and practice.

Community Rates Methodology 
The Department of Social and Health Services (DSHS), Developmental Disabilities Administration (DDA), 
requests $72,964,000 ($36,499,000 GFState)and 1.0 FTE to create equitable funding for DDA Home and 
Community Based-Service (HCBS) providers; increase diversity and improve professional development 
of direct support professional work force through support staff to improve verbal and written 
communication skills in English; protect Category 4 Health Insurance Portability and Accountability Act 
(HIPAA) client data; and keep up with inflation and the cost of goods and services. 

Medicaid Provider Rates 
The Department of Social and Health Services (DSHS), Developmental Disabilities Administration (DDA), 
requests $4,060,000 ($1,822,000 GFState) to help stabilize the Home and Community Based Services 
(HCBS) sector. The COVID19 pandemic and the resulting Public Health 
Emergency has put great strain on the HCBS system and exacerbated previous staffing, workforce, and 
reimbursement issues. Dramatic changes in caseloads, increased needs for enhanced services, 
increasing inflation, and the unprecedented workforce shortage have created a serious threat to the 
viability of maintaining the provider network. 

Developmental Disabilities Administration 
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Direct Care Workforce 
Direct Care Workforce: The Department of Social and Health Services (DSHS), Developmental 
Disabilities Administration (DDA), requests $6,586,000 ($3,688,000 GFState) and 24.0 FTEs for 
recruitment, retention, and ongoing quality support of state employees. Direct care staff working in 
state operated settings, field services staff delivering case management services, and recruitment of 
new staff are experiencing unprecedented challenges with staff moving to the private sector for 
increased pay, significant retirements, and people leaving their jobs due to the pandemic. 

2022 Legislative Session Implementation Status 
No-Paid Caseload 

• Add Case managers for DDA clients who do not have paid services.

• Hiring is on track to support phased in implementation. Report to the legislature is due
12/1/2022.

Enhanced Case Management 

• Expansion of program to support DDA clients identified at being at high risk of abuse or neglect.

• Hiring is on track to support phased in enrollment in expanded program.

Modifying DDA Services 

• Courtesy Forecasting of DDA HCBS Waiver capacity.

• The Caseload Forecast Council plans to present draft forecasts at the November 9th meeting.

Youth Behavioral Health Navigators 

• DDA received funding for a program manager FTE dedicated to the development and support of
HCA’s Youth Behavioral Health Navigator program. Additional FTEs were requested in the FY23–
25 biennium to have identified DDA staff throughout the state with responsibility to participate
in community teams that support youths in WA with I/DD and ASD diagnoses.

Transitional Care Management 

• Create Transition coordination teams

• Project manager started 5/16/22.  Establishment and hiring for other positions are underway
with transition teams beginning work in regions. DDA System improvements being undertaken
as part of this project include increased collaboration to develop consistent processes across
program areas for like activities such as referral process, client transfers, communication of
services to promote client and families understanding and provider recruitment.

Enhanced Community Residential Rate 

• Rate increases for residential providers.

• Rate increases are fully implemented and anecdotally providers report some improvements in
their ability to hire and retain staff.

Back to table of contents



Early Childhood Special Education 
(ECSE) Updates 

Early Childhood Outcomes (Indicator B7) 
The federal Office of Special Education Programs (OSEP) requires local school districts to report 
outcomes data for every student in preschool who receives special education services through 
an Individualized Educational Program (IEP). Early childhood outcomes data are collected when 
a student begins to receive special education services (usually around age 3) and again when 
the student exits from preschool, including to enter a Transitional Kindergarten program. 

The goal of early intervention and early childhood special education is to enable young children 
with disabilities to be active and successful participants during their early childhood years and in 
the future.  

• ECTA Center: Aligning a Child's Functional Skills with the Breadth of the Three Child
Outcomes

• ECTA Center: Child Outcomes
• Early Childhood Outcomes (Indicator B7) | OSPI
• Early Childhood Outcomes Reporting Guidance | OSPI

LRE and Regular Early Childhood Programs 
The Dear Colleague Letter on Preschool Least Restrictive Environment outlines where preschool 
aged children might receive IDEA services, and defines the "regular class" as a "preschool setting 
with typically developing peers". All programs have the responsibility to meet the needs of all 
children in their care. State ratios for programs vary by age of the child, type of program, and 
funding requirements. To ensure FAPE, the LEA may provide services to a child in programs 
operated by community partners, such as Head Start or community-based childcare, or private 
preschool.  

• Decision Tree/Flow Chart
• LRE Calculator
• CEDARS Manual

New Documents to Encourage Collaboration Between State 
Agencies, Local Agencies and Head Start 
The U.S. Department of Education's Office of Special Education Programs, and the U.S. 
Department of Health and Human Services' Office of Head Start are releasing new documents to 
encourage collaboration between state educational agencies (SEAs), local educational agencies 

Partners can look at the larger Special Education Update here: 
October 2022 Special Education Update (govdelivery.com)
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(LEAs), and Head Start programs to effectively meet the Individual with Disabilities Education Act 
(IDEA) requirements.  

• Dear Colleague Letter on Individuals with Disabilities Education Act (IDEA) Services in
Head Start

• Guidance on Creating an Effective Memorandum of Understanding to Support High
Quality Inclusive Early Childhood Systems

These documents make clear that SEAs, LEAs, and Head Start programs all have responsibilities 
for implementing IDEA to ensure that children with disabilities enrolled in Head Start programs 
receive a free appropriate public education in the least restrictive environment. 
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The SEAC was pleased to host our ICC partners Darci Ladwig and E Renae’ Antalan for a virtual training 
by Technical Assistance for Excellence in Special Education (TAESE) in August. SEAC also met in-person 
and virtually at the Medical Lake School District Wellness Center on October 18 and 19th and heard a 
presentation called “Mind Your Health” from Medical Lake Director of Student Services - Tawni Barlow, 
Superintendent – Tim Ames, Assistant Superintendent – Kim Headrick. MLSD offers free wellness 
Workshops/Classes for families, staff, educators, and community members on a variety of topics and 
offers mental health services. MLSD implements a Multi-Tiered System of Supports for students, has a 
school on Fairchild Airforce Base, and is recognized as Purple Star School District. MLSD offers preschool 
and transitional Kindergarten to families living on the base and provides transportation for early 
childhood students receiving special education services.   

The next SEAC meeting will be held virtually in February 2023. 

Other information - Focus Areas for 2022–2023 include: 

• Recommendation 1: Creation of a new two-way system of accountability through which the
SEAC requests concrete and measurable actions aligned with recommendations and OSPI
provides regular updates on these requests.

• Recommendation 2: Continue collection and analysis of disaggregated data and
recommendations regarding graduation pathways. Clarify where the accountability lies for
ensuring access to graduation pathway options with significant disabilities, such as behaviors.

• Recommendation 3: Continue the efforts of OSPI to leverage best practices in providing
technical assistance and partnership to districts, families, and education groups.

• Recommendation 4: Convening of joint meeting between the SEAC and DCYF Interagency
Coordinating Council (ICC).

• Recommendation 5: Collection and analysis of data on the collective impact of special education
funding in relation to braided funding and impacts on BIPOC students with disabilities.
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From Boarding School to 
Resiliency

FROM THE HEART

DISCLAIMER: DO NOT TAKE THIS PERSONAL OR ACCEPT THE BLAME
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Take a little journey with me



Tulalip boarding School

 https://youtu.be/2TMjIDF4ho8

https://youtu.be/2TMjIDF4ho8


Colonel Richard Pratt

 1879 Established the Carlisle Indian School in Carlisle, Pennsylvania

 His motto was “KILL THE INDIAN TO SAVE THE MAN”

 His intention was to completely assimilate Indian Children into white society



Assimilation

 Forbidden to speak our Language

 Forbidden to practice our Spiritual Beliefs and to use our songs and dances

 Military Experience rather than Traditional Parenting Practices

 Take away our traditional hunting and gathering

 Trained to be blacksmiths, farmers, seamstresses,

 Half the day on industrial training and other half on academics

 Termination

 Relocation
 How has that affected our Tribes





Losses that we have Suffered

 Loss of our Language
 Loss of Cultural Lifeways; hunting, gathering, 

traveling
 Loss of traditional parenting skills
 Loss of our Identity
 Loss of our Lands



What we Gained

 Generational Trauma in our DNA

 Physical and Mental Abuse 

 Alcoholism

 Multiple issues on the ACES scale

 Poor sense of identity



Resiliency

 We are still here

 We regained our opportunity to practice spirituality in the Longhouse 
through providing “treaty days”

 In 1972 our tribe had 750 tribal members and now we are over 5,200.

 We have worked to revive our Language and to practice our Spiritual 
Ways. In the 70’s our grandparents gathered in the community to work on 
saving our language

 In 1992, our tribe received our first grant to do Language Revitalization. 

 Our Canoes brought back more of our Cultural Ways through Canoe 
Pulling, Sharing Songs, Dancing and sharing stories and teachings with our 
young people since 1989 “Paddle to Seattle



Resiliency continues

 Betty J Taylor Early Learning Academy brought all of our Early Learning 
Programs under one roof to help us be consistent with our education for 
our Birth to Five Children. 

 Started providing language to our Birth to three children five years ago 
and it is making a difference.

 Sharing with Birth to Five children is key to our resiliency as they grow up 
knowing who they are and experiencing our traditional language, stories, 
songs and foods. 

 Developing relationships with families is key to success for our children
 One of the things that we experience now is our child visitors that moved 

to our new school.



First Traditional Clam Bake at BJTELA

 https://www.facebook.com/TulalipNews/videos/3355922571331577/

 https://vimeo.com/722754743
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www.dcyf.wa.gov

PowerPoint Accessibility
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Laws & Guidelines
• Americans with Disabilities Act 

Title II
• Section 504 of the Rehabilitation 

Act of 1973
• Section 508 of the Rehabilitation 

Act of 1973
• Web Content Accessibility 

Guidelines 2.0/2.1 Level AA
• WA Office of the Chief 

Information Officer – WCAG 2.1 
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Visual 
o Blind
o Low Vision
o Color Blindness

Auditory
o Deaf
o Hard of Hearing or Hearing Loss
o Auditory Processing Disorder

Motor
o Spinal Cord Injuries
o Multiple Sclerosis (MS), Cerebral Palsy 

(CP)
o Arthritis, ALS, Parkinson's Disease, etc.

Cognitive
o Memory, Problem-Solving
o Attention deficits (ADHD), Math and 

Visual Comprehension deficits
o Reading, linguistic, and verbal 

comprehension, etc. 

Disability Types
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Assistive Technology (AT) 
• Any product or service that makes 

tasks easier or possible.
• Types of AT

• Hearing AT
• Speech Communication AT
• Vision AT
• Motor or Mobility AT
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• How Do People with 
Disabilities Use Computers 
(1:03)

• Screenreader demo (5:20)
• Dragon NaturallySpeaking 

Demo (5:06)

• Magnification Software Demo 
(1:44)

• Keyboard Navigation Demo 
(1:46)

Assistive Technology Videos

Original Date: Month XX, 20XX
Revised Date: Month XX, 20XX

Division
Approved for distribution by Name, Title

www.dcyf.wa.gov

https://www.youtube.com/watch?v=0fd7bzVJkKc
https://www.youtube.com/watch?v=fBuPswP0B_M&feature=youtu.be
https://www.youtube.com/watch?v=kJKQmTumFP0
https://www.youtube.com/watch?v=aCPc_I_W2MA
https://www.youtube.com/watch?v=N9Q8oF0Lx2M
http://www.dcyf.wa.gov/
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Creating an accessible PowerPoint
Note: I will be jumping in and out of presentation mode to be able to show 
the various features listed below.
• Built in templates and themes
• Slide layouts
• Slide reading order
• Alternative or Alt Text
• Simple Tables
• MS Office Accessibility Checker
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Templates, Themes, Layout
• Built-in themes and downloadable templates can change the look of 

presentations.
• Be cautious about contrast.  Some built-in themes have low contrast which 

can impact how visually accessible of the slide.

• Slide Layouts
• One of the most important part of accessible PowerPoints.
• When used correctly, layouts ensure information on the slides have the 

correct heading structure and reading order.
• Every slide requires a title.  The slide title can be visually hidden.
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Templates, Themes, Layout Demonstration
• Exit out of Presentation Mode
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Slide Reading Order 

• By default, screen readers will read the slide title first, followed by 
other content in elements defined by the slide layout.  Then it will 
read any additional content in the order it was added.

• If adding content is required, make sure to check or change the 
reading order.

• Home>Arrange>Selection Pane
• Note: The reading order for the elements on the selection pane is bottom to 

top
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Slide Order Demonstration
• Exit out of Presentation Mode
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• Any product or service that makes 
tasks easier or possible.

• Types of AT
• Hearing AT
• Speech Communication AT
• Vision AT
• Motor or Mobility AT

Demonstration Slide Reading Order
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Alternative Text
• A textual substitute for non-text content.

• Images
• Pictures

• Screen readers announce alternative text in place of images, helping users 
with visual or certain cognitive disabilities perceive the content and 
function of the images.

• Right-click>Edit Alt Text
• Images that are decorative only and have no content, leave alt text field 

blank and check Mark as decorative 
• DO NOT select “Generate a description for me” button
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Alt. Text Example 1a: youth laying on pebble 
beach in dramatic fashion – okay alt. text

Alt Text Example 1b: A student is laying in 
the rocks at the beach playing dead. He was 
our loudest kid in the group who didn’t like 
to ever stop talking so I dared him to 
meditate in silence for five minutes when 
we went to the beach and apparently this is 
what the student thinks meditation is, LOL –
better alt text

Alt Text Example 1
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Alt. Text Example 2a: 4 youth, 2 boys 
and 2 girls standing in front of large 
moose statute with Northwest Trek 
sign in background. – Okay alt. text

Alt Text Example 2b: All four students 
are standing in front of a large 
moose statue at NW trek. They have 
big smiles on their face. – Better alt 
text

Alt Text Example 2
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Tables

• Purpose: present tabular information in a grid, or matrix, and to have 
column or rows that show the meaning of the information in the grid.

• Strongly encouraged NOT to use Tables in PowerPoint due to 
accessibility difficulties.
o Instead use bulleted lists.
o If tables are used additional work is needed.

 Must send PowerPoint as a Word or Rich-Text-Format (RTF)document for users needing 
accessibility. 

 Suggestion: Send out to all users both formats
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Converting a PowerPoint into Word/RTF Format 
Demonstration

• Exit out of presentation mode.
o File>Save As
o Under File Name click Save As Type> Choose Outline/RTF>Save As
o Display Outline/RTF format of current PowerPoint
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Links
• PowerPoint will automatically create a link when pasting or typing a full URL 

onto a slide and hitting Enter or Space.
• Raw URLs may not make sense to screen reader users or others, so make link 

text descriptive.  Avoid URLs.
• Screen readers generally inform users that a piece of text (or graphic) is a link.

o No need to include “link” in the link text.

• Tabbing from link to link is a way of skimming content for screen readers.
o Links should make sense out of context.  Phrases such as “click here,” “more,” “click for 

details,” and so on are ambiguous when read out of context.  
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Link Example
• Exit out of presentation mode.
• Instead of this: 

o https://webaim.org/techniques/powerpoint/#links
 To change link text:

 Right click link>edit hyperlink
o Change Text to Display to:

 WebAIM Introduction to PowerPoint Accessibility – Links

• If creating a presentation intended to be displayed both electronically and in 
print, you may want to include the URL and a description in the link text.
o For Example, “WebAIM Introduction to PowerPoint Accessibility – Links” 

(https://webaim.org/techniques/powerpoint/#links)

https://webaim.org/techniques/powerpoint/#links
https://webaim.org/techniques/powerpoint/#links
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MS Office Accessibility Checker
• The Accessibility Checker built-in to MS office can identify many common 

accessibility issues.
• The checker will present accessibility:

o errors 
 images with no alternative text,
 Tables has no header row

o warnings
 unclear link text,
 Table has merged or split cells,

o tips 
 Check slide reading order for slides with custom content 

• File>Info>Check for Issues>Check Accessibility
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Resources
WebAIM: Articles
WebAIM: Accessible Documents: Word, PowerPoint, & Acrobat Training
Make your content accessible to everyone with the Accessibility Checker 
(microsoft.com)
Level Access: Accessible & Inclusive digital experience YouTube page

https://webaim.org/articles/
https://webaim.org/training/docs/
https://support.microsoft.com/en-us/office/make-your-content-accessible-to-everyone-with-the-accessibility-checker-38059c2d-45ef-4830-9797-618f0e96f3ab?ns=powerpnt&version=19&ui=en-us&rs=en-us&ad=us
https://www.youtube.com/c/LevelAccessA11y/videos
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Thank you!
Contact:

Karin Morris, DCYF ADA Coordinator
Karin.morris@dcyf.wa.gov

360-480-7230
& 

Janet George, DSB Youth Service Program Specialist
janet.george@dsb.wa.gov

206-906-5530

Back to table of contents

mailto:karin.morris@dcyf.gov
mailto:janet.george@dsb.wa.gov
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YEAR-ROUND FUNDING

Problem: 

Early Support providers are required by IDEA Part C to deliver services year-
round. Although children and families benefit enormously from the continuity of 
year-round support, per state law, WA calculates ESIT funds assuming 180 days 
of service per year based on the school model. Thus, ESIT providers are 
systemically underfunded (at 10/12 months per year, or 83% of the year.)



YEAR-ROUND FUNDING

Solution:

 Update the ESIT funding model to reflect year-round services by increasing the 
ESIT per-child special education rate by 20%, representing the 2 months added 
to the current 10-month funding formula. This preserves the fundamental ESIT 
funding formula, which is appropriately tied to dynamic state special education 
rates, while also accounting for the requirements of a year-long Early Support 
system. 

 In FY23, DCYF forecasts it will spend approximately $110 million on ESIT. An 
additional 2 months to fund ESIT year-round would cost the state an additional 
$22 million/year. 



FIRST MONTH BILLING

Problem:

State law specifies that ESIT providers may only count services for the purposes 
of billing DCYF if those services were provided in the month prior to the monthly 
“count day.” Effectively, this means providers are not able to bill f or their 1st month of 
services, although the 1st month tends to be the most expensive.



FIRST MONTH BILLING

Solution: 

Ensure that providers can “count” all children being served in each month for 
the purposes of billing DCYF by amending RCW 43.216.580. ESIT providers 
should be able to count a child as receiving Early Support services starting from 
the date at which their Individual Family Service Plan is in place. 

Back to table of contents 
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